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Overview
Windows Reminder is a Windows application that maintains a "to do" or "task" list of items
that you want to be reminded of. An "item" can be thought of as a specific event such as

Dinner at 6:00 with Fred
Bank Open new account

Since time is not required, so you can make a list of errands to do for any day, and print it
out to take it along with you, or give to others as a reminder for them.

This list can be used to keep track of your items as well as for others in your family or work.
If you choose not to delete the item, you will have a log of items you accomplished. This
comes in handy when you need to give a status report of your work or progress on a project.

Windows Reminder uses DDE, see DDE with Reminder, so you can automatically generate a
standard status, time logged or month end report.

See the Getting Started section to get up and running quickly.



Getting Started

How to quickly get going with Reminder.

Beginners
WININI settings

Internationalization
Networks




Beginners

The quickest way to get started is to start a list.
You only need two pieces of information.

1. A date and

2. A message.

A category is set to the default unless you create a category by pressing the F4 key.
Categories allow you to group related items for viewing and reporting purposes.

You can also supply some optional information such as Time, order of importance, and if the
item has already been done or not.

The Category is used to group or view related items together.

How you name your categories will be useful for you to quickly see different items. Here
are some samples that you may use for different places.

For more information on different uses, see the Reminder Uses section.



WININI settings

Reminder uses the following setting in WIN.INI. If they are not there, the defaults are used.
[Reminder]

Path full path name to the data files.
Modem the Com port to use and setting - defuault isCOM1,T,2
Prefix the prefix to be placed in front of the number.

Note: See the Internationalization section for more uses.




Internationalization
Windows Reminder supports Internationalization for the date and time displays.
The setting in WIN.INI that Reminder looks for in the [intl] section are:

s1159 AM character- default is "a"
s2359 PM character - default is "p"
sTime time separator - default is ":"
sDate date separator - default is "/"
sShortDate short date format - default is M/D/Y
iTime 0 = 12, 1=24 hour format - default is 0
iDate O0=m/dly 1=d/m/ly 2 =y/m/d-defaultisO
The setting in WIN.INI that Reminder looks for in the [Reminder] section are:
sDays The three character days - default is
"badSunMonTueWedThuFriSat"
sDaysl The 1 letter character used in Calendar - default is "SMTWTFS"
1-12 The months used for Calendar - default is 1="January"

12="December". Note: month can be up to 13 characters.



Networks
Reminder uses the following search routine to determine where the data files are.
1. The full path and filename from the command line.
2. Current directory
3. Checks the WIN.INI file for the [Reminder] path= location of the files.
4. Directory where Windows Reminder is loaded from.
5. Directory where Windows was started from.



Reminder Uses

Here are some of the different uses of Windows Reminder.
For work:

Meetings Project name Reports Lunch Calls

Reports are generated very quickly along with a time log of each event.
See the DDE with Reminder section for more details.

For the home:
Child's names can be used as the category entry so you can see at a glance which child has
to be where for what event.

Birthdays Child 1 Child 2 School Practice

For other time related items:
Medication  Car related maintenance Bill paying Doctor visits

To create a new category, just enter it in when you enter the item. You can also set up all
you categories at once by using pressing the F4 key or select the Category Add menu
command.

You will be shown a dialog box in which to enter a category name. See the Category Dialog

for more information.

Once you have one or more categories, you can then start adding Items with the "+" or F5
key.

An item is one line of information that describes what you want to be reminded about.
You attach a category to each item so that you can quickly view all related items at one
time. An example of this is all the doctor visits, or meetings in a month. Attaching a
category also allows you to quickly generate reports for more than one purpose.

The least amount of information you need to create an item is

1. a date (this defaults to todays date)
2. a category (which you can select from a list) and
3. a message.

Power Users
After you have your list made up, you will want to explore the power.of DDE with WinWord
and Visual Basic to see how to automatically generate reports and time spent on each item.



Keyboard

+
Enter
Space

Fl
F4
F5
F6
F7
F8
F9
F10
F1l1
F12

Ctrli+Ins
Shift+Ins

Add a new ltem

Delete currently selected item
Change currently selected item
Check item as done.

Help

Add a new Category

Add a new ltem

Delete currently selected item
Change currently selected item
Check item as done.

View items in the past

View items for today

View items for the future

View items that are done

selects the Copy menu command
selects the Paste menu command






Control Bar
ElEl | $][=]v][*]A 9w

The control Bar is provided for you to quickly point and click to get different commands to
occur.

==

The first button you see is for bringing up the Calendar program.
The second button is used from bringing up the Phone Dialer dialog.

H=llalle]

This group of buttons allow you to edit the currently selected item(s).

The "plus" sign, il is used to Add a new item.

The "minus" sign,E is used to Delete selected item(s).

The "triangle" sign,E is used to Change a selected item.

v

The "check mark" sign, is used to mark the selected item(s) as done.

«| $]=]~][*]

This group of controls are the view item buttons. They allow you to view the items based
on the date and if they are "done" or not.

The "past" sign, A is used to display items that came before TODAY.

The "today" sign, ¥ is used to display items that are for TODAY only.

The "future" sign, n

The "done" sigiz

is used to display items that come after TODAY.

is used to display items that are done.

The "All" sign,‘i is used to display ALL items. You will also notice that it pushes all the
other "view" buttons down.

A

This is the Alarm indicator. It is displayed automatically when there is a time set to go off
some time today. If there are no times set, the alarm picture will not be shown.

The current time on your computer is displayed at the end of the Control bar.



Slider Bar
Done | Date| Time |Category |Mote

You can use the "slider" bar with the mouse to change the width of the columns you want.
Reminder will remember the position from the previous session.



Calendar

Use can start the Calendar program from the Window Show Calendar menu or from Window.
It is a stand-alone program so Reminder does not need to be running or around to work.

You can quickly move it out of the way by pressing one of the arrow keys in the direction you
want it to move.

Viewing other months and years.
+ +

To view a different month, use the mouse to click on either the right or left arrows.

+ ¥

To view a different year, use the mouse to click on the inside of the right or left arrows.

Entering a new item with Calendar.

You can use Calendar to enter a "new" item in Reminder by just double-clicking the left
mouse button on the date you want. Reminder will bring up it's "Enter new item" dialog
with the date you picked already inserted! If Reminder isn't running, Calendar will start it
for you automatically.

Entering the date with Calendar.

To enter a date or change the existing date, just double-click the left mouse button on the
date you want.

Entering the time with Calendar.

To enter a time or change the existing time, just single-click the right mouse button on the
time you want. If you want pm, 7-6 default to PM, or you can get 1:00p by selecting the
13th date which tells reminder to use the 13th hour of the day.



Alarm setting

=\

The way the alarm is set is by providing a time with an item. If the date is today and the
time has not already past, then the alarm picture will be displayed.

If you want to create your own sort options, you can do this by going to the Options
Preferences menu command and un-checking the "Allow only time" checkbox. This will
allow you to enter in text such as ASAP, NOW, 1, 2, 3... and it will be sorted by what you
have.

Why the alarm picture is not displayed.
Here are a few things to check.
1. Make sure your system date has the correct YEAR and the time has the correct AM
or PM setting. You can verify and set your system date and time by running

-
Control Panel. == and then selecting the Date/Time
icon.
2 Check the Action item to make sure it is not set to Nothing.
4 Check the Options Preference menu command and make sure the Allow only

time box is checked.

3: Make sure that the A or P letter is at the end of the time setting. 3:00p
5.

The alarm will only come on if:

the date is today,

the system time isn't past the current time

6. If it is today and you think the time has not passed, then check the Options Alarm
menu to see if the Advance warning number is not set too high so that the system time you
wanted to be warned about is now in the past.



File
The file menu command

gives you access for printing your items. You have extensive use

of the View options to determine what you want printed.

Print Preview

Print...
Printer Setup...

@ icon.

Select Printer...

@ icon.

Exit

Before you actually print your list, you have the option to see what

the list will look like. If you want more space in between a column,

you can then use the Slider Bar to change the margins.

This will print the list that you currently see.

This allows you to set up any new printers you have connected to
=l

you computer. This can also be done using the Control Panel. ey

and then selecting the printer

Before doing any printing, you should tell Windows Reminder which
printer you want to use. All printers that are currently set up in the
system will come up for you to choose from. Select the
appropriate printer before printing. If you don't do this, Reminder
will use the default printer as set up through the Control Panel.

=y
== and then selecting the printer

This will exit the program.



Edit

The Edit menu command allows you to maintain your items.

Copy

Paste

Add...
Delete...
Change...
Check

F5
F6
F7
F8

Saves what you have selected with the "view" buttons to the
Clipboard. See Copying data from Reminder

Copies text items from the clipboard to create new items. See
Pasting data to Reminder

Note: Don't do this twice unless you want duplicate items.

Add a new item.

Delete selected item(s).

Change a selected item.

Mark the selected item(s) as done.



View

The View menu command allows you to easily view your items in different ways.

All items
Past F9
Today F10
Future F1l1
Done F12
Select All

View All

Shows you ALL items no matter what.
Shows you items that came before TODAY.
Shows you items for TODAY only.
Shows you items that come after TODAY.
Shows you items that are marked as "done".
This will toggle on and off all the categories at a time. This is
useful when you want to select all the categories except one or
two.
View ALL the categories.

L)l 2] %]

Category: ALL View: Past, Today. Future

The Control Bar buttons will toggle in and out when you press the keys and the Window
caption under the Control Bar will also show you what View is currently selected.



Category
The Category menu command allows you to maintain your categories.

Add...F4 Add a new category
Delete... Allows you to delete a category not in use.
Change... Change the name of a category



Options
The Options menu command allows you to customize Windows Reminder to work the way
you like to.

Alarm... Allows you to set the sound and optional chimes. If you have
multimedia installed, the setting you have defined in control
panel are used.

Preferences... Allows you to set the way you like to see the information.*
Run... Allows you to start other applications and DDE conversations.
Dial... Allows you to have your modem dial a phone number for you.

The preferences dialog allows you to customize how Windows Reminder works with
you.

You can turn color on and off.

It allows you to get rid of the Delete confirmation dialog.

It allows you to save deleted items to a file with the date you marked it as done. Each
item is saved in a file called item.YMM, where Y is the year and MM is the month.

It sets the way you want to see the date displayed, for the day or year.

It allows you to not display each due item at start-up time.

It allows you to set the default setting for "Business Day only" in the alarm message.



Window
The Window menu command allows you to display the Calendar program and determine if
you want the Control Bar displayed.

Show Calendar Starts or displays the Calendar program EEiii
Show Control Bar Allows you to show or not show the Control Bar



Help
This Help file can be entered from Windows Reminder by pressing the F1 key. Extensive use
of hot links can be found throughout this help file for easy access to Windows Reminder's

operation.

Index Gets you to this help file.
About... Displays the version number.



Dialogs
Here is a list of the dialog boxes Windows Reminder uses.

Action

Alarm Message
Category Dialog
Item

Run

ial

-



Action
You can select what action to take when an alarm goes off. Here is a list of what each of the
different actions gives you control over.

Nothing Dose nothing when the time is reached.

Show Message Displays the messages you typed in. See the Alarm Message
section for more information.

Show Item This will bring up the Item dialog box.

Run Runs an application or file extension you supply.

Run with prompt Same as Run except a dialog box is displayed so that you can
change the text, or choose not to run the command. See the
Run dialog for more information.

DDE Starts a DDE conversation with the specified application.

DDE with prompt. Same as DDE except a dialog box is displayed so that you can
change the text, or choose not to run the command. See the
Run dialog for more information.

Dial Displays the phone dial dialog box with the second line of the
Iltem dialog box being the phone number you want to dial.




Alarm Message
You can select what action to take when an alarm you set goes off. Here is a list of what
each of the different actions gives you control over.

Mark as Done This will check the item as done. Use with the Ok button.

Note Displays the message you entered.

Note 2 Displays the second message line you entered.

Repeat Snooze or Repeat the alarm in X minutes from now. Must be
used with the "Reset Time" button.

Re-schedule This will bring up the Item dialog box so that you can change the

date or time or anything else you need to.

When an alarm goes off, your message is displayed for you. You are then given 4 choices of
what you want to do with the message. The first is nothing so that you can decide what you
want to do with it later. You can select the "Mark as Done" check box to indicate you no
longer need to be reminded of the message. If you are busy when the message is displayed
you can set the "Repeat in ? minutes”, (snooze) option and press the "Reset Time" button so
the message will be displayed again in the extra time you selected. This is really handy
when you are on the phone. Selecting the "Re-schedule" button brings up the message for
editing so that you can change the date and/or time and any of the other information at one
time.



Category Dialog

Here you can enter in the name of a new category you want to group your items by. This is
handy for viewing what you have done and also what you have to do. You can also use this
to print out a list of items to do for today to take along with you.

Text required. Name of category, no spaces are allowed.

Personal The check box flags this category as personal so that these items
will not be included in DDE conversations unless the specific
category is asked for. This way, your Birthday items will not be
on your reports.



Item

The Item dialog is used to enter, and change items you want to keep track of.

Done
Category
Date

Time

Length

Warning
Action:

Note
Note 2

Check box
required. Create new category with the F4 key.
required. Format is mm/dd/yy "/" can be "-". This area is also

free form in that you can enter just one number and it will default
to the current month and year. You can also leave out the year
and it will default to the current year.

Hint: For an easier way to enter in the date, use the Calendar
program with a double click of the left mouse button.

not required. This field has two formats depending on what you
have selected in the Options Preferences "Allow only time" option.
If you have time selected, the format is hh:00[a|p]. However,
this area is also free form in that you can enter just one number
and it will default to the hour you want. The ":00" and "a" or "p"
is put in automatically. If it guesses wrong, just put in the "a" or
"p" yourself.

Hint: For an easier way to enter in the time, use the Calendar
program with the right mouse button.

Note: The time will only default if you specify the Options
Preferences "Allow only time" option. This can be turned on and
off at anytime. The option only affects new items entered or
changed.

Default times of 1-6 are made into PM unless "a" is placed at the
end.

Note: Not using the time option allows you to make this a Priority,
department list or whatever you want to sort on. See the Alarm
setting section for more information.

not required. This field has one format, but you have to decide
on if you are going to use whole hours or minutes. You will
usually modify this value after you have finished the item so that
your reports have the correct amount of time logged.

not required. This field is used to set how far in advance you
want to be notified of the event.

required. Here you are allowed to take the following actions when
the alarm goes off. See Action for more information.

required. Free form text.

Free form text.

Add this will add the item to your list and works with the Enter key.
Close this will close the dialog box and works with the Escape key also.



Run

There are two ways to get to the Run dialog. The first way is when you set an alarm and
you specify the Action of "Run with Prompt". You can also get to the Run dialog by selecting
the Options Run menu command.

Note Displays the note you entered for this action.
Run Enter the application or DDE conversation you want.

In the Run line, you can enter any program name with a list of parameters.
Here are some items you can enter and their results.

calc Starts the Calculator application
test.xls Starts Microsoft Excel with the test.xls file



Dial

There are two ways to get to the Dial dialog. The first way is when you set an alarm and
you specify the Action of "Dial". You can also get to the Run dialog by selecting the Options
Dial menu command.

Note Displays the note you entered for this action.

Dial Enter the phone number you want dialed.

Ok this will dial the number.

Cancel this will close the dialog box and also works with the Escape key.

Setup this will allow you to change the default setting to your modem.



Importing and Exporting Data
Reminder has a number of ways of importing and exporting data with other applications.

Two ways are to use the Clipboard.
Copying data from Reminder  Transfers data to the clipboard.
Pasting data to Reminder Transfers data from the clipboard.

Two other ways are to use DDE.
Poking data to Reminder An application sending data to Reminder.
Requesting data from Reminder An application getting data from Reminder.

Deleted items are saved to a text file if the Options Preference is selected. Each field is
separated with a TAB and at the end of each line is the actual date you maked the item as
done. This makes it easy to generate reports with time related information.



Copying data from Reminder

When Reminder copies information to the Clipboard, the data is in text (CF_TEXT) format and
each field is separated with a TAB. This allows for easy pasting to Word processors and
spread sheet programs. Reminder will place all the items currently viewable into the
clipboard. So, if you want to select just a small amount of data to the clipboard, you will
have to set up the View Category menus and Past, Present and Future buttons to just display
the items you want placed on the clipboard.



Pasting data to Reminder
When Reminder receives information from another application or from the Clipboard, it will
look for the following as the minimum amount of data required to make a new item:

date
category
note
Example: 5/15/91 Meeting Give a status on Projectl to everyone.

You can also supply any of the additional information and it will be accepted.

[done] - only the "x" character is allowed
date

[time]

category

note

[TAB note 2]

Each data field is separated either by a TAB or space.

Note: The TAB is required to separate the first note from the second note.

Warning: To allow a flexible number of fields, you should make sure everything is correct
and that you make a backup each day.



Working with other applications

Reminder has a number of ways of working with other applications.

1. It can start running other applications un-attended.

2. It can be a DDE Server application to provide or accept information.

3. It can be a DDE Client to start other DDE applications or retrieve information from other
DDE applications.

Starting other applications
Poking data to Reminder
Requesting data from Reminder
WinWord Report Sample




Starting other applications
Reminder can automatically start up other applications for you at a specific time and run
macros for you to further automate your job. See the Run section for complete information.

Reminder can start two different kinds of applications.
1. A regular Windows or MS-DOS application or
2. A Windows application with DDE commands.

To start a regular Windows or MS-DOS application, just supply the name of the program and
optional data file to be passed to the application. To start WinWord, just type

WinWord
in the Note2 section, select the "Action" to Run, and it's set to start it at the specified time.



Poking data to Reminder

Let's say you are in WinWord and have a date for your next meeting listed. You want to be
able to "select" the date, and text to be posted to Reminder. So you highlight in the text
starting at the date to the end of the first message or second message if you want one.
Then just pick the menu "Post to Reminder" menu.

Here is a sample macro on how to pass an item from WinWord to Reminder.

Sub MAIN
ChanNum = DDEInitiate ("reminder", "items")
DDEPoke ChanNum, "all", Selection$ ()
DDETerminate ChanNum

End Sub



Category information
For a specific category, you use the C=string command, where "string" is the name of the
Category you want.

C=Meeting Returns me only the items with a category of Meeting

C=Project Returns me only the items with a category of Project

Hint: Characters can be in upper or lower case.
Note: For multiple categories, you just make another Request.



Requesting data from Reminder
Reminder can pass information back to your application. You can request everything or just
a specific type of information.

To limit what Reminder will pass you, Reminder will recognize the following one character
formats.

C Category information
D Done information
M Month information

Combining requests together sample.




Done information
For a list of the items that were finished or marked as "done", you use the D=V, where D
stands for Done and V can be one of the following:

NoroO for Not done

Y for done

If you do not specify either Y or N, then you will get
the items no matter if they are done or not, i.e.

d=n Returns me only the items that are NOT done
d=y Returns me only the items that ARE done.
<none> Returns all since a preference was not provided.

Hint: Characters can be in upper or lower case.



Month information
For a specific month, you use the M=N, where N is the month number, i.e. 1=Jan, 12=Dec.
M=5 Returns all items for the month of May

Note: If you need more than one month, then you just make a separate request for each
month. Characters can be in upper or lower case



Combining requests together
You can combine both the month and done requests together to
get the following information.

Returns me ALL the items in the month of May.

Returns me the items done in the month of May.

Returns me the items NOT done in the month of May.

Returns me ALL the items in the month of June.

m=6 c=test Returns me ALL the items in the month of June with the category of "test".

Qo
[}
=

3333
I
Ut

Hint: Characters can be in upper or lower case.



WinWord Report Sample

For a working example, please see the REMINDER.DOT file.

Here is a sample macro that automatically asks Reminder to divide the information in three
parts.

1. What you have done for the month

2. What you didn't do for the month

3. What you have planned for next month.

This is all done at the selection of a menu command.

Sub MAIN
ChanNum = DDEInitiate ("reminder", "items")
Insert "Here is what I did for the month." + Chr$ (10)
Insert DDERequest$ (ChanNum, "m=5 d=y")
Insert Chr$(ll) 4+ " —————————————— " + Chr$(10)
Insert "I did quite a bit of work as you can see."
Insert "Items that I was not able to get done this month."
Insert DDERequest$ (ChanNum, "m=5 d=n")
Insert Chr$(ll) + " —————-—-—-—m—mm " + Chrs$(10)
Insert "Items that I have scheduled for next month." + Chr$(10)
Insert DDERequest$ (ChanNum, "m=6")
DDETerminate ChanNum
Insert Chr$(10) + " —-—=—=———————————-———————— " + Chrs(10)
Insert "Let me know if I missed anything." + Chr$(10)

End Sub



DDE with Reminder
Windows Reminder supports DDE as both a Client and Server.

Reminder as the Server

To use Reminder as the Client, you enter one of the following DDE commands into the Run
dialog.

Execute Command

Post or Poke Command

Request Command




Reminder as the Server
Windows Reminder will work as a DDE Server after you start a conversation with the
following keywords.

AppName Topic(s)

Reminder Iltems This is the one you use to get data items.

Following are the System topics Reminder supports.
Reminder System
Formats
Sysltems
Status

To start a Windows application with DDE commands, just supply:
1. the type of DDE command (examples follow)

2. name of the program

3. and the type of data you want to pass to the program

Reminder recognizes the following keys to send commands.

=Execute Execute a command in the other application
=Post Post (Poke) information to the application
=Request Request information from the application

Hint: Characters can be in upper or lower case.
Note: The "=" is required so that Reminder knows this is a DDE command rather than a DOS
command.



Post or Poke Command
What you would use the Poke command for is to send a specific bit of information to the

other application.

Here is how to use the Poke command.
=Poke AppName TopicName reference data

The following sample will place the text "Hi" into cell A1 in Sheetl if the sheet is open.
=P Excel Sheetl rlcl Hi

For more information see Poking data to Reminder or Pasting data to Reminder.

Hint: Characters can be in upper or lower case.



Execute Command

What you would use the Execute command for is to tell the other application what to do for
you. This can be anything from opening a new WorkSheet or Document to a complex set of
tasks to do an entire of calling back to Reminder or Excel, gathering the information,
formatting it, and then printing or sending it out via Email to others.

Here is how to use the Execute command.
=Execute AppName TopicName [data]

The following sample will create a new WorkSheet in Excel.
=E Excel Sheetl [new()]
Hint: Text can be upper or lower case, and you only need one space between words.



Request Command

What you would use the Request command for is to get information from the other
application. This can be anything from getting a stock price, month end total to a phone
number of a person you are being reminded to call.

Here is how to use the Request command.
=Request AppName TopicName reference

The following sample will create a new WorkSheet in Excel.
=R Excel Sheetl Total

This gets the information/value that is in the cell referenced by the name Total.

Hint: Characters can be in upper or lower case.



Hints and Tips

How to get the most out of this program.

You can use the Calendar program, CAL.EXE, to start up Reminder

Use Calendar to enter dates and time - it's fast and easy.

You can use Reminder to startup a DDE conversation with WinWord that will then have
WinWord get the information from Reminder to put into your Report!

Use Reminder for tracking length of time each item took to complete.

Saving deleted information to a file allows you to also track when items were marked as
done.

Setting the alarm.
If the alarm doesn't come on, see the Alarm setting section.



